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Chapter One:

Welcome to Microsoft Expression Media Reader

Microsoft® Expression® Media Reader enables you to share Microsoft Expression Media
catalogs with anyone on the Macintosh or Windows platform at no cost or restriction. You can
burn Expression Media Reader and catalogs to CD or DVD, send by email, or send across a
network so others can view them.

Expression Media Reader is free to download and distribute and works on both the Macintosh
and Windows platforms. Expression Media Reader opens catalogs written by Microsoft®
Expression® Media, iView Media, and MediaPro 1.5, 2.x or 3.x. Expression Media Reader is
compatible with the full 120+ media file formats of Expression Media and includes the Slide
Show function of Expression Media.

Expression Media users create catalogs that they can subsequently save and distribute. Users
who do not own Expression Media can then use Expression Media Reader to view, label, rate,
and comment on distributed catalogs. Expression Media users may choose to distribute only the
catalog or include original media. However, Expression Media Reader does not allow the viewer
to make any alterations to a catalog or to create new catalogs.

You do not have to purchase Expression Media to use Expression Media Reader.

System requirements

This section lists the minimum system requirements for Expression Media Reader (with the
recommended ones in parentheses). It is important to have the most recent version of Apple®
QuickTime® installed. This will improve the performance and functionality of Expression
Media Reader.

Microsoft Windows:
e Intel® Pentium® 111 500 MHz processor or equivalent (Intel Pentium 4)
e 1GBof RAM
e 1024 x 768 display with 24-bit color
e 100 MB of hard disk space for installation
e Microsoft® Windows® XP (XP SP2) or Microsoft® Windows® Vista™
e Apple QuickTime 7.1.5 or higher
e Microsoft® Internet Explorer® 5.5 (6.0) and higher
e DirectX 9.0c



e Adobe® Reader® 7.0 or higher for PDF file support

Apple Macintosh:
e Expression Media Reader supports Intel®-based Macintosh
PowerPC® or Intel Core Processor
DVD-ROM drive
Apple® Macintosh® OS X (10.4.8 or later)
Apple QuickTime 7.1.5 or later
Monitor set to Millions of Colors
100 MB of hard disk space for installation
512 MB of RAM or more

Installing Expression Media Reader

There are slightly different methods for installation, depending on the operating system you are
using. After installation, you will need to type in the license key.

To install Expression Media Reader on Windows
1. Insert the Expression Media Reader CD or DVD.
2. Click Install Expression Media Reader, and then follow the instructions.

Note: If this menu does not appear, your PC might not support AutoPlay. In this case,
open the CD or DVD and run Media Reader.xx.exe, where xx is the country code.

To install Expression Media Reader on the Macintosh
1. Insert Expression Media Reader.

2. Double-click the Install Expression Media Reader icon, and then follow the
instructions.

To change languages on the Macintosh

1. Open the application.

2. Click the Expression Media Reader icon.
3. On the File menu, click Welcome Screen.
4

Expand the Languages menu. On installation, Expression Media Reader defaults to the
operating system language. To run in a different language, clear all languages except the
one you want.

To change languages in Windows

When you install Expression Media Reader, you select a language. To change languages,
reinstall Expression Media Reader, and then select an alternate language from the menu.
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Language support

By default, Expression Media Reader uses the language of the operating system or remembers
the last language used. For information about how to change the language used by Expression
Media Reader, see the section “Microsoft Windows:

Intel® Pentium® I11 500 MHz processor or equivalent (Intel Pentium 4)

1 GB of RAM

1024 x 768 display with 24-bit color

100 MB of hard disk space for installation

Microsoft® Windows® XP (XP SP2) or Microsoft® Windows® Vista™
Apple QuickTime 7.1.5 or higher

Microsoft® Internet Explorer® 5.5 (6.0) and higher

DirectX 9.0c

Adobe® Reader® 7.0 or higher for PDF file support

Apple Macintosh:

Expression Media Reader supports Intel®-based Macintosh
PowerPC® or Intel Core Processor

DVD-ROM drive

Apple® Macintosh® OS X (10.4.8 or later)

Apple QuickTime 7.1.5 or later

Monitor set to Millions of Colors

100 MB of hard disk space for installation

512 MB of RAM or more

Installing Expression Media Reader in this chapter.

Web resources

You can access additional resources for learning Expression Media Reader on the Expression
Web site. Tutorials, customer support, forums, and application updates are available online. Go
to the Web site at http://go.microsoft.com/fwlink/?LinkID=82546
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Chapter Two:

Microsoft Expression Media Reader Basics

Before you get started with Expression Media Reader, there are some basic concepts that you
need to know about how it imports, lists, and categorizes files. This chapter reviews the tasks
necessary to create and work with your first catalog.
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Access most of the major functions of Expression Media Reader by clicking buttons on the toolbar
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Setting Expression Media Reader preferences

You can define additional setup and program options in the Preferences dialog box. The
preferences are divided into several categories. You can access the preferences by clicking the
Edit menu, and then pointing to Preferences. Setting some of these preferences requires that you
have a working knowledge of the features that they control. Use the following indicated
references to learn about and set the corresponding preferences.

e General These preferences define some of the global display and general behavior
characteristics of the program.

Options 3

AtStartup: |Open New Catalog  ~|

Double-Click: | Switch Views v

Options: || Show tooltips for toolbar buttons

| Sort using natural order

i)

i
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m
T
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(%]

Field Mames: |I'~"Iicrusuf't Expression Mi + |

Dimensions: | Pixels = |
Resolution: | Pixels/Inch - |
Dates: |Shurt - |
Inspector Key: 7 Point to any media item or organizer list
Ok | | Cancel

General preferences

e Labels and Colors These preferences enable you to customize the colors and names of
labels globally. Color labels provide a method of a visual identification and classification
of media files in your catalogs. For more information about labels and setting these
preferences, see “Labeling your files” on page 19.

To set general preferences
1. On the Edit menu, point to Preferences, and then click General.
2. Set the options according to the following descriptions.



At Startup Choose whether you want to open a new catalog, open the last catalog
you used, or do nothing every time you launch the application.

Double-click Choose how Expression Media Reader interprets double-clicking a
media item in a catalog.

Options Select how to display tooltips to sort media based on natural numerical
order (1, 2, 3...), to show warning dialog boxes when batch processing or removing
media, and to auto-save catalogs on a timed schedule.

Field Names Define the field names to use for describing IPTC annotations.
Dimensions Define which unit of measure that Expression Media Reader uses.
Resolution Set the default resolution.

Dates Determine how the date displays in the views. If you choose Long, the date
format will be Friday, April 16, 2006. If you choose Short, the format will read
4/16/06. If you choose Abbreviated, the format will read Fri, Apr 16, 2006
(Windows only).

Inspector Key Type a key that you can press to get more information about a media
item or Organizer term when you have the cursor positioned over the item or term.



Microsoft Expression Media Reader

Chapter Three:

Viewing files in catalogs

The Microsoft Expression Media Reader interface displays information in three different views:
List, Thumbnail, and Media Reader. To switch views, click the appropriate tab.

Thumbnail

View tabs in Expression Media Reader
All three views offer features that resemble the way you work with your files on the desktop.

To find a file Type the first letters of the file name.
To change a file name Click the name and type a new one.

To use functions from the menu (Windows) Right-click the thumbnail representative of the
media item (Macintosh: CTRL-click), or anywhere inside the Expression Media Reader window.

To rearrange items Drag the items to where you want them, and then drop them. You can drag
single items or multiple selections.

To copy or move items to another catalog Drag the items from one catalog to the other.

To move the original files Drag the relevant catalog items to a folder or to the desktop. This
will move the file from its current location to the desktop.

To copy files from the catalog to the desktop Hold down the CTRL key (Windows) or
OPTION key (Macintosh) while dragging files to the desktop.

To launch items with another drag-and-drop application Drag the items onto the application
shortcut (Windows) or alias (Macintosh).

To invert the order of media in any catalog view Click the Invert button 7 |in the upper-left
corner of the media viewing area.

To change views (Microsoft® Windows® XP and Microsoft® Windows Vista™) CTRL + 1, 2,
and 3 respectively or (Macintosh OS X) 3 1, 2, and 3 respectively. In this way, you can view
the tabs.



Selecting multiple images

If you want to batch process your images, Expression Media Reader offers several ways to
quickly select a group of items.

e Selection commands:
a) Choose Edit.
b) Choose Select All.
c) Select Clear All or Invert Selection.

e A continuous block of items Click the first item and, hold down the SHIFT key, and
then click the last item of your selection.

e A selection of non-adjacent items Hold down the CTRL key (Windows) or 3 key
(Macintosh) while selecting individual items.

e A selection of non-adjacent blocks For example, to select items 1 through 10 and 20
through 30, click 1, press SHIFT+click 10, press CTRL+click 20, or 38+click
(Macintosh), or press SHIFT+click 30.

e Expanding a selection Select an item or block of items and expand the selection by
pressing the SHIFT key and one of the arrow keys. The LEFT and RIGHT ARROW keys
increase the selection by one item. The UP and DOWN ARROW keys increase the
selection by a row of items.

e Selection scripts On the Scripts menu, point to Select, and then click Landscape,
Portrait, or Square. The command Landscape selects all items in the catalog that are
horizontal. Portrait selects all items that are vertical. Square selects all items that are
perfectly square items.

e Selecting based on criteria To select items that match a particular attribute (Capture
Date, File Type, Label) or annotation (Event, Location, Categories, Keyword), click the
dot next to a field term in the Organize panel’s Catalog Fields index, and the
corresponding items will appear in the active view. This will hide all images that do not
match that annotation or attribute. Once the appropriate images are shown in the active
view, on the Edit menu, click Select All.

You are now ready to perform a number of functions by selecting them at the same time. As an
alternative, you can choose Select Media Reader Items from the individual field menu. This
selects all items associated with that attribute in the active view.

List View

List | Thumbna
£ File Name File Size File Type | Width Height Duration | Path Name
lEl BRUSHSCLTTF 52.2kB TrueTyp... COur Files\005_Fonks\BRIJSHSCLTTF
l:l PRISTIMNA. TTF 50.7 KB TrueTyp... CAour Files\005_Fonks\PRISTIMNG. TTF
F<] rempstre.TTF 74.3KE  TrueTyvp... C:\Our Files\005_Fonts\ TEMPSITC. TTF
Bl 5GAZ0061208514.CR2 11 ME Canon R... 4365 291z Ciour Filesiool_Maturel R Files\SGAZO061 208514, CR2
SGAZO0612091144,CR2 7.8 ME Zanon R, 3504 2336 CHiour Filesi00l_Mature\RAW Files\3GAZ00612091144,CR2
B 5GA200612130075, CR2 13,7 MB Canon R 4368 2912 CH0ur Filesi00l _Mature\RAW Files\SGA200612130073.CR2
B s54200612130708. CRE 5 MB Canon R, 3504 2336 CiOur Files'001_Mature\RAW Files\SGA200612130705,CR2
B 55420061 204356, jpg 916.4KE  JPEG 1200 00 C:\our Files\001_Maturel 5GAZ0061204356,jpg

The List View
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In this view of a catalog, your media appears in a list of small icons beside information fields of
your choice, such as file name, size, type, duration, and so on. Movie Thumbnails show a small
video icon to help differentiate them from still images. The path for the location of the file and a
media-related description appears in the header.

To sort the list according to a field, click the corresponding field label in the Header bar above
the list area. To rearrange the order of header fields, click and drag the field name to a new
location. Notice that some information is dependent on the file type. For example, the Duration
field applies only to movies and sounds.

To change the size of thumbnails in this view, on the Size menu 2 , click Small Icons or Large
Icons.

Though the icons are small, movies and music will play in List View. To change the view, select
a file and press the SPACEBAR. You can also change views while the file is playing.

Thumbnail View

Thumbnail | Media

HE & & & & ¢ R & & & & ¢

SGA200612130293.jpg 5GA200612130447.jpg SGAZ00612130497.jpg

Mature Movie,avi Icon04.png Icon0S.png

The Thumbnail View

Click the Thumbnail tab to select this view. This view displays the catalog as a table of
thumbnails in adjustable sizes. When you select an item in the table, the Header bar shows the
item file name, dimensions, file size, and file type. You can change the size of the thumbnail by

clicking a choice in the Size menu “*/. Note that if the catalog does not include a thumbnail that
is the size that you choose, then you cannot change the thumbnail size.



Media View

This view displays media files at full size, one file at a time. Unlike other views, Media Reader
View is a real-time presentation of the original media files onscreen. This means that Expression
Media Reader needs to have access to the file; otherwise, you will get an error message such as
“File Not Found.”

In Media View, you can play animations, movies, and sounds, or navigate inside a QTVR image.
Use the onscreen QuickTime controls to interact with movies, music, and QTVR. You can also
flip through the pages of a PDF or view the various layers of an Adobe® Photoshop® document
using the Pager tool that appears in the Header bar.

When an image does not fit entirely inside the window, the cursor changes to a hand. Use the
Hand tool to move the image. Use the RIGHT ARROW key to advance to the next image. Use
the LEFT ARROW Kkey to go to the previous image in the catalog.

Playback of media

Expression Media Reader can play a wide variety of music, video, and multimedia files. They
can be played in any view, including slide shows.

|:| backqround
Stereo - 44100 Hz - 16 bits
0:24
S i i
Playing back an audio file

To start playback, select the file you want to play, and then click the Play Media Reader button
&~ on the toolbar. Or, you can press the SPACEBAR. To stop the playback, press the toolbar’s
Play Media Reader button or press the SPACEBAR.

In Media Reader View, media files such as video, music, Flash, and QTVR are displayed with
QuickTime controls. You can use these controls to regulate playback and control volume. Or,
you can click the toolbar’s Play button and press the SPACEBAR to start and stop playback.

One unique feature of Expression Media Reader is that you can switch between List View,
Thumbnail View, and Media Reader View while playing a file, without altering playback
quality. To change views, click the appropriate tab.

Play list mode

Play list mode enables you to play the files of a catalog in a continuous sequence. This feature is
not selected by default. If you want to select it, on the Play menu, click Playlist Mode.

This feature is useful when you have a catalog of MP3 files that you want to audition, or a
sequence of video or still images that you want to watch. Expression Media Reader will
continuously play the files in your catalog in a loop until you stop it.

To start a play list, select the file you want to begin with, and then click the Play Media button
on the toolbar. Or, you can press the SPACEBAR. To stop the playback, press the toolbar’s Play
button or press the SPACEBAR.



Microsoft Expression Media Reader

Play list mode also automatically advances through a catalog of images, which is particularly
useful in Media Reader View. This feature simulates a slide show, while allowing you to see
information panels open alongside the images. You can adjust the delay (short, medium and
long) between images in the Stills Pause section of the Play menu.

When you turn Play list mode off, you can still play media, however Expression Media Reader
will not advance to the next media item on playback completion of a selected item.
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Chapter Four:

Media Reader Annotations

Microsoft® Expression® Media Reader enables you to view a wide variety of image metadata in
industry-standard metadata fields.

The Info panel

When a media file is created by a computer or digital device, information is embedded into the
file to describe it. This information is called metadata, and it is used by software programs to
accurately understand the media file.

Expression Media Reader uses the Info panel to provide an instant look at the combined
properties and metadata of a media file, such as file type, size, dimensions, resolution, caption,
capture date, and duration. Based on the media type, this information will change.

You can check the accuracy of information within this single user-configurable list with no need
to remember to open multiple dialogs. The data inside the Info panel is split into various
sections. To show the data from one of these groups, click the arrow next to the section name.

% SGA200612130078.jpg
4 Media Info
Media Type Image
File Type PEG
Encoding Photo - FEG
File Size 1.1M8
Disk Name -
Orientation Default
Dimensions 1200 x 800 pixels
Resoluton 300 pixels/inch
Depth 24bits
Compression 1:2
Color Space RGB
Color Profle SRGB IEC61966-2.1
Pages 1
Created 3/2/2007 3:48:42 AM
Modified 3/2/2007 9:48:42 AM

Thumbnail Size 10366 bytes
ize  478bytes
259 bytes
Obytes
e Adobe Photoshop ...
Source Devics Canon ECS 5D
4 Photo EXIF
EXIF Version 2.2
Capture Date 2006:12:12 22:27:45
Aperture 7.1
shutter Speed 1j2sec
Exposure Bias +0.0
Exposure Program  Aperture Priority
Focal Length 40.0mm

Flash OFF - Compulsory ...
Metering Pattern
150 Speed 320
- Annotations
4 People
4 Keywords
South Geargia
King Penguins
Sunrise
Mauntaing

The Info panel
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To show or hide the Info panel
Do one of the following:
e Click the Info button.

e If the Info panel is showing, click the border between the panel and the views and drag it
to the left until the Info panel disappears.

Below is the Media Info section that you can display in the Info panel.

i1 SGA200612130078.jpg

4 Media Info
Media Type Image
File Type JPEG
Encoding Photo - JPEG
File Size 1.1MB
Disk Name -
Crientation Default
Dimensions 1200 x 800 pixels
Resolution 300 pixelsfinch
Depth 24 bits
Compression 1:2
Calor Space RGE
Calor Profile sRGE IEC61966-2. 1
Pages 1
Created 3/2/2007 9:48:42 AM
Modified 3/2/2007 9:48:42 AM
Annotated
Thumbnail Size 10386 bytes
Annotations Size 478 bytes
Metadata Size 259 bytes
Recording Size 0 bytes
Source Software Adobe Photoshop ...
Source Device Canon EQS 5D

Media Info section

Media Info This field displays embedded media-related metadata that cannot be edited. It
includes some data that your computer assigns to a file, such as type, size, creation date, and
modification date.

Other fields display information based on the media type. For example, image files display
dimensions, resolution, bit-depth, color space, and profile. Audio files display the type of
encoding, length of the music, audio channels, and data about the quality of the sound.

Expression Media Reader also displays the size of text annotations, audio annotations, and
thumbnail associated with an item in this section.

Special, extended media-related metadata are displayed in their own section. They are as
follows:

13



4 Photo EXIF

EXIF Version 2.2

Capture Date 2006:12:12 22:27:45
Aperture fr.1

Shutter Speed 1/2 sec

Exposure Bias +0.0

Exposure Program  Aperture Priority
Focal Length 40.0 mm

Flash OFF - Compulsory ...
Metering Pattern

150 Speed 320

Photo EXIF section

Photo EXIF For images created by digital cameras, the Info panel displays special data (EXIF)
that has been captured and embedded in the photo file. This metadata includes the date and time
a photo was taken (Capture Date), as well as camera-related information, such as shutter speed,
aperture, and exposure. Global Positioning System (GPS) information can also be displayed in
this section. Different cameras record different amounts of EXIF data. Only the EXIF data
captured by your digital camera will be displayed here.

Annotations Expression Media Reader supports a set of pre-defined fields for annotating media.
This set (also known as the IPTC Core) includes fields that enable you to define the author, event
date, event information, copyright, labels, ratings, and more.

IPTC stands for the International Press and Telecommunications Council. Since the late 1970s,
the ITPC has focused on developing industry standards for the interchange of news data. The
IPTC annotation fields used by Expression Media Reader comply with the standards set by this
organization.

These fields are also part of the Adobe metadata standard called XMP (Extensible Metadata
Platform). Expression Media Reader can read XMP metadata in four image file types: .jpg, -tif,
.dng, .png, and Adobe Photoshop.

Description The Info panel also provides an area to write descriptions of media, which is useful
for additional details or thoughts about the files. Descriptions embedded into files are
automatically shown in this field.

Keywords These are useful for describing and organizing the content of your media.

Cue Points (Audio and Video) Some audio or video media files contain markers, or cue points,
which define special time stamps in the file. For example, an audio file might have cue points
that mark the chorus, bridge and solos of a song. Expression Media Reader lists the name and
time stamp for all cue points of an item in this section.

Movie Tracks (Audio and Video) Movie files usually contain two tracks of digital information:
one for video and one for audio. However, movies can contain multiple video and audio tracks.
This section displays the type of encoding, start time, duration, data size, data rate and frame rate
for each video track of the movie file. For audio files, which only contain one track, this section
displays the type of encoding, start time, duration, data size, and data rate.
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Caption section

The Info panel also provides an area for you to view descriptions of media, useful for additional
explanation or thoughts. The panel displays any comments or messages that the image creator
entered.

Field names

Some software programs use different names for the various IPTC/XMP field names. For
example, Photoshop CS calls the IPTC Job Identifier field, Transmission Reference. Expression
Media Reader provides you with the option of selecting which field names to display—the
official IPTC Core names, those names used in Expression Media Reader, or those used in
Photoshop CS.

To change the displayed field names
e On the Edit menu, point to Preferences, and then click General.

Field names do not affect how annotations are written (synchronized) into media files. It is
merely a visual preference designed to help you choose the appropriate field when annotating
files.

15



Chapter Five:

Reviewing and Marking Media

You might want to review and classify the media in a catalog that someone sends to you. For
your purposes, you can rate and label media in a catalog and, though you cannot save those
ratings, you can use them to help you sort and identify the images.

To assist in this process, Expression Media Reader provides two methods of classifying and
ranking media: star ratings and color labels. Using keyboard commands, you can easily assign
labels and ratings in any view, the Light Table and during slide shows.

Rating media

Star ratings provide a ranking system for items in your catalogs. You can now rank your media
from one to five stars, or mark them with no stars.
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To assign arating
Once you have selected one or more items, you can add a rating in three ways.

e Select a star rating from the Rate Media menu @/ on the toolbar, or by right-clicking to
get a contextual menu.

e Press ALT + 1-5 (CTRL+1-5). This applies the associated rating (for example, 3 equals
three stars).

To remove ratings
Select one or more of the following items:

¢ Click None on the Rate Media drop-down menu on the toolbar, or right-click the file in
any view.

e Select an item and press ALT+ the number zero (0) or (Macintosh: CTRL+0.)
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To show files associated with a rating
Select one or more items.
e Click a rating in the Rating section of the Catalog Fields index of the Organize panel.

e On the Find menu, click Show Rated, and then select a rating value of items you want to
be displayed.

Color labels

Labels provide a visual identification and classification system for items in your catalogs.
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For example, you can use a color label to mark favorite items, mark items to delete, archive, or
convert, or you can track items that are in different stages of a workflow. You can adjust the
colors for aesthetic preference or to better match the tone or contrast of a particular view
background color. You can also match colors to a labeling scheme in another application or
environment.

After you label your items, you can quickly sort the catalog by using the labels in the Catalog
Fields section.

Label options

To accommodate your desired method of marking items, you can customize the colors and
names of labels as a global application preference. Because this customization is global, shared
catalogs inherit the label names and colors of the user that is opening the catalog, and not the
preferences of the person who created the catalog.
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Labels

Label Titles and Colors

Use labels to create visual groups of media items in
catalogs. To assign a label to a media item press any
key from 1 to 9. Press 0 to remove labels.

OK ] [ Cancel

Label options window

To customize labels

1.

On the Edit menu, point to Preferences, and then click Labels and Colors (Windows)
or Labels (Macintosh).

Click the color swatch you want to change.

Select any label text and type a new name. Customizing a label name helps to remember
the label’s purpose or definition.

(Macintosh only) If you select the Apply to original media file option, then labels
assigned to items in your catalog will also be applied to the original file. For example, if
you assign a label #1 in a catalog, then label #1 will be assigned to the file on the
desktop. However, though the label numbers may match, it is possible that the colors will
not match.

To restore the default label colors and names, on the Options menu, click Reset All.

On the Options menu, to save a group of label preferences, click Export to File. After
you have saved the labels to a file, these label preferences can be loaded into other
installations of Expression Media Reader using the Import from File option.

Note: Custom names that you use for labels become indexed as search terms for associated items
in Expression Media Reader. For example, if a label is named “Client Picks,” then any free-form
text search in the Expression Media Reader toolbar for the word “client” will return images
assigned with that color label.
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Labeling your files
You can assign and remove labels in any view.

To assign a label
1. Select or display one or more items.
2. Do one of the following:
e Select a color from the Assign Label menu @ - on the toolbar, or right-click

(Windows) or CTRL-click (Macintosh), point to Label, and then select a color from
the list.

e Press a number key (1 through 9). This applies the associated color (for example, 1 =
Red).
To remove labels
In any view, select or display one or more items, and then do one of the following:
e From the Assign Label menu on the toolbar, select None.
e Press the number zero (0).

To show files associated with a label
Do one of the following:
e Click a color label in the Labels sections of the Catalog Index.

e On the Find menu, click Show Labeled, and then select a label value of items you
want to be displayed.

Note: Labeled files can also be sorted during slide shows. To create a slide show, use the Show
Labeled menu from the Slide Show controller.

19



Chapter Six:

Organizing Catalogs

Expression Media Reader gives you many options for categorizing and optimizing your catalog.
Your catalog functions as a window to all of your files. Expression Media Reader gives you the
power to organize your files any way you like so that your view of your files is completely
customized according your workflow or storage needs.

Moving media in catalogs

To rearrange items in a catalog, you can drag and drop them, singly or in groups, or you can use
other move options available on the View menu.

To move media in catalogs
1. In List View or Thumbnail View, select the file or files that you want to move.
2. Drag the files to a new location in the catalog.

The Organize panel

Use the Organize panel to sort the catalog files in a variety of ways. To show or hide the
Organize panel, click the Organize button on the toolbar.
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Catalog Fields index

The Catalog Fields index is useful for global searches or groupings, allowing a quick comparison
across hundreds of files, often revealing annotation inconsistencies among a large number of
files. By viewing your media from a global rather than an individual perspective, you can make
sure of the standardization and accuracy of annotations across your media.

To expand a field, click the arrow next to its name.

The Catalog Fields index lists all annotations or tags present in the catalog.

The following categories are in the Catalog Fields index:

Label and Rating Use this group to show files with a color label or star rating.

Catalog Sets These are a freeform, hierarchical method of organizing media files. You can use
sets to organize play lists, photo albums, projects, or work assignments. Most users utilize sets to
quickly display subgroups of items in a catalog, and to maintain their order. Any media item can
belong to more than one set, allowing catalogs to be logically organized into sets for different
projects, clients or themes, without confusing the overall annotation or classification of files in
the catalog.

Date Finder Lists the specific date that a file was created. For each file, Expression Media
Reader displays one of three date criteria:

e |PTC Date Created
e Digital camera Capture Date (EXIF)
e The File Creation Date

If a file has all three dates, Expression Media Reader uses the IPTC Date Created as the primary
date for display in this list.

File Type Shows a list of all media sorted by the file format, such as .tif, .jpg, .mpg, MP3, and
SO on.

Event, Author, People, Keywords These fields present alternative metadata to further
distinguish and categorize the files.

Locating media by fields
You can filter the catalog by using the Catalog Field index.

To find files that match an attribute (Date, File Type) or annotation (Event, Author, and so on),
click the dot next to term in the Catalog Fields index, and the corresponding files appear in the
active view. This hides all files that do not match the annotation or attribute, which is useful for
finding a particular group of files that can now be batch processed, exported, reorganized, or
printed.

After you have found the files you want, on the Find menu, click Show All to reveal all the
hidden files in your catalog. To show all files, you can also click Show All Items on the toolbar.
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Chapter Seven:

Finding and Sorting Media in Catalogs

In open catalogs, Microsoft Expression Media Reader offers a number of ways to find and sort
media files, as well as related files, media, and tag attributes.

Searching your catalog

You can search catalogs quickly and accurately in Expression Media Reader. You can perform a
quick search in the active catalog directly from the search box in a catalog toolbar, or you can
perform a more detailed search using the Find command. Searching is case-insensitive and
includes all annotations (EXIF, IPTC annotations, descriptions, and so on), media fields, and
catalog set names.

After you have searched and have found the items you want, on the Find menu, choose Show
All to show all the items in your catalog. You can also click the Show All Items button on the
toolbar.
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The Find dialog box

To quickly search the active catalog
Type the word or words in the search box in the catalog toolbar, and then press the RETURN or
ENTER key, or click the Search # button.

To search catalogs using the Find command
1. On the Find menu, click Find.

2. To refine your search, use the choices in the menus to specify particular file
characteristics to search for. Type the word or words that you want to search for in the
search box. To add or subtract search criteria, use the plus (+) and minus (-) buttons in
the upper-right corner of the dialog box. To use Boolean search criteria, choose and or or
in the respective menu.

3. To customize the results of your search, choose one of the following options from the
menu in the lower-left corner of the Find dialog box.
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e Find next Highlights the first item that meets your search criteria.

e Selectall Selects items that meet your criteria.

e Show all Hides all items in the catalog that do not meet your criteria.
e Show all in a new catalog Places all matching results in new catalog.

4. To save your search, click the icon in the upper right corner of the Find dialog box.
Searches can be saved for later recall on the menu in the upper-right corner of the Find
dialog box.

5. Press the RETURN or ENTER key.

Filtering and sorting by metadata

Use any of the below methods to sort and display your files according to their metadata or file
attributes.

To filter files using the Organize panel
1. On the toolbar, click Organize.

2. To display items that match an attribute (date, media format) or annotation (events,
locations), or that are all in a particular set, click the dot next to the field name in the
Catalog Field index of the Organize panel. To select multiple attributes or annotations,
press CTRL+click (Windows) or 3+click (Macintosh). The dot turns green when
Expression Media Reader uses the filter.

To sort files according to attributes
1. On the toolbar, click the Sort menu @/,

2. To sort the media items, choose criteria.

3. To return to the organization method of the last saved version of the catalog, click
Default.

To sort by column in the List View

Click the corresponding label in the header bar above the media viewing area. To invert the sort
order, click the arrow on the far left of the header bar.

To restore your catalog to display all files
Do one of the following:

e Click the Show All Items leutton. Or, you can use the state arrows to navigate back
and forth among various states that your catalog has shown during the searching and
sorting process in the Organize panel.

o Click the State Arrows at the top-left of the toolbar to navigate back or forward to a
previous display state.

Filtering by multiple terms
There are several ways to use the Organize panel for complex catalog filtering and sorting using
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multiple metadata terms. You can filter either by intersecting terms, which enables you to
display media items that have both “keyword A” and “keyword B” attached to them, or you can
filter by a union of terms, which enables you to display all media items that have either
“keyword A” or “keyword B” attached to them.

To display files with intersecting terms
1. Open the Organize panel, and then expand the Keywords group.

2. Inthe List Configuration menu at the top-right corner of the Organize panel, make sure
that there is not a check mark next to Union of Terms in Repeating Fields.

3. Inthe area for the “keyword A,” click the gray oval to right of the keyword name that
contains the number of catalog items associated with that keyword. When you click this
gray oval, a green dot should appear, and the items associated with that keyword should
be displayed in the active view.

4. Hold down the CTRL key (Windows) or the 3 key (Macintosh) and then click the gray
oval next to the keyword you want to intersect with “keyword A.” A green dot should
appear in the gray oval for this keyword as well.

5. The final display should contain only images that have both keywords, “keyword A” and
“keyword B.”

Union of terms

To display all media items that have “keyword A” and all media items that have “keyword B,”
repeat the intersection instructions, but instead, select Union of Terms in Repeating Fields in

the Organize panel’s List Configuration menu “='. You do this by selecting the keywords on the
List Configuration menu. This function applies only to metadata fields that can have multiple
terms, such as Keywords and People.

Handling a hierarchy of terms

In the Organize panel, some metadata fields have terms displayed in a hierarchy. In other words,
these terms consist of a heading, followed by the items that correspond to that heading. These
terms include Catalog Sets, Catalog Folders, Date Finder, and the Place Finder. For example, the
Date Finder term lists your photos in a hierarchy according to year and month. By default, you
can only filter photos by the lowest term in the hierarchy, which in this example, is by day. A
key option named Union of Field Hierarchies, located in the List Configuration menu in the
Organize panel, enables you to expand your filtering opportunities by allowing you to filter items
according to the higher hierarchies.
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Date Finder hierarchy, without Union of Field Hierarchies option selected

If you do not select the Union of Field Hierarchies option, the Organize panel displays only the
number of media items associated with each sublevel of any hierarchical metadata group,
including Catalog Sets and Date Finder.

For example, suppose you are viewing 100 photos taken on varying months in 2004 and you
want your catalog to display only those photos. Without the Union of Field Hierarchies option
selected, you will have no way of filtering your images according to year. You can only filter by
the lowest term in the hierarchy, which is the date.

However, if you select the Union of Field Hierarchies option, the higher levels of any
hierarchical metadata group in the Organize panel will display the aggregate number of media
items associated with any sub-levels of the hierarchy. Thereby, you can then filter your photos
by year, as well as by other levels of hierarchy above date, such as month.
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Date Finder hierarchy, with Union of Field Hierarchies option selected. Note the sum of files in a particular
category is now in parentheses, and that you can now filter your files by that category.

In some hierarchies, such as Catalog Sets, when you set the Union of Field Hierarchies option,
the panel displays two numbers. The first number represents the number of cataloged items that
are stored in that folder or set. The second number is in parentheses and it represents the number
of cataloged items stored in all subfolders or subsets.

To select or clear the Union of Field Hierarchies option
On the Configure List menu, click Union of Field Hierarchies to select or clear it.
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Chapter Eight:

Viewing Images in Slide Shows and the Light Table

Expression Media Reader enables you to view or project a slide show presentation with your
photographs, movies, and audio soundtracks.

-

The Expression Media Reader Slide Show feature enables you to sequentially present your files using a
variety of transitions and displays.

Slide Show basics

The Slide Show feature in Expression Media Reader offers a way for you to display a succession
of images and movies, as well as play audio. You have full control over the transition between
files as well as which files play, how they transition, and, if applicable, the amount that displays
or plays at one time. The slide show can function as anything from a preview tool, to a way to
construct a complete, stylish movie of your media collection since, if you want, you can save
your slide show as a movie file that you can distribute.

Slide Show features

By default, the Slide Show feature is set to run with cut transitions and to cycle through your
collection. You can run a slide show at any time. A floating slide show controller appears when
you start a slideshow. Use the options on this controller to adjust all the aspects of your slide
show.

Following are some of the features of a slide show:
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Audio Expression Media Reader slide shows can contain a single, background audio channel.
Sound items included in a catalog are always queued into the audio channel. If you place an
audio file at the beginning of a slide show of images, the audio plays during the presentation.

Video Expression Media Reader slide shows can display up to 16 video channels. All media
types (including images or movies) play in one or more video channels, depending on your grid
selection.

Grids These are the arrangement of video channels, in full-screen, quarter-screen, or a variety of
other options. Unless you are using a computer with a powerful processor, using the slide show
feature with more than one video channel will place considerable strain on your computer and
degrade playback. We recommend that you first experiment with Half or Quarter video channel
grids before choosing more complex grids.

Timing Expression Media Reader lets you specify how long still images will appear in the
presentation, however, movies always appear for their full duration. To adjust the timing of
images (in seconds), use the up or down arrows next to the green number on the right hand side
of the controller.

Transitions Expression Media Reader offers several options to adjust the transition effect
between images. There are 10 different slide show transition effects, such as Cross Fade, Barn
Horizontal, and Radial Wipes, as well as a Random Effect option.

Effects defined in the Transitions menu of the slide show controller apply globally to all images
of the slide show.

Size of Media Reader To adjust the size of onscreen media, use the Scale menu of the slide
show controller. You can enlarge or reduce the size of your images by pressing the PLUS (+) or
MINUS (-) keys. This setting will apply globally to all images of the slide show.

Viewing the Slide Show

You can run the Slide Show at any time during your work. If, as it runs, you want to vary the
playback, you can do so while you are in Slide Show mode.

To run a slide show
1. Do one of the following:

e Click the Run Slide Show button & on the toolbar.
e On the Make menu, click Run Slide Show.
2. To exit during the slide show, click the ESC key or double-click a Slide Show image.
You can also click the Exit Slide Show button *' on the Slide Show controller.

Slide Show controller

The Slide Show controller panel lets you adjust options during a slide show presentation. Though
you can set the same global options that you set in the Slide Show Options dialog box, the Slide
Show controller also enables you to set individual playback options for each of the files that
display so that you can further customize your slide show. You can change any option even as
the slide show plays.
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This palette is also useful for running presentations on a second screen or projector. If you use
multiple monitors, position your catalog inside the monitor you want to use for the slide show.
You can start the presentation on that monitor and keep the controller on the other monitor.

If you are not using two monitors, displaying the Slide Show controller on top of the slide show
stage will impair viewing.

To show or hide the controller, press ENTER or RETURN.
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Slide Show controller
1) Adjust volume; 2) Exit Slide Show; 3) Slide Show options; 4) Playback controls; 5) Adjust time between
transitions; 6) Show/Hide files; 7) Playback options; 8) Filtering options; 9) Scroll lock

Slide Show options

As you run the slide show, a controller appears that you can use to set the global options for the
slide show and, in addition, set options for each image in the slide show. For information about
using the Slide Show controller, see “Slide Show controller” on page 28.

To access the global options
Do any of the following:

1. On the Set Options menu *!, locate the option category that you want to set, and then
select an option.

H

el

2. On either the Set Transitions menu 24/ Set Scaling menu ®/ or Set Grid menu &I
choose an option to apply to the entire slide show presentation.
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3. Set the options according to the following guidelines, and then click OK.

To lock the scrollbar

Click the Scroll Lock icon in the Slide Show controller. This prevents the display of files from
scrolling as the slide show plays.

To adjust the volume of playback
Click the arrows to the left of the speaker icon in the controller.

Set Options menu
Following are the options that appear in the Set Options menu.

Interactive Use this option with the LEFT and RIGHT ARROW keys of your keyboard
to manually advance or go back in your presentation. The UP and DOWN ARROW keys
work the same as LEFT and RIGHT ARROW keys.

Continuous This is the default for Expression Media Reader slide shows. Images will
appear onscreen for the specified duration, and then automatically advance to the next
image. Movies will appear onscreen for their full duration, and then automatically
advance. You can use the SPACEBAR to Pause or Play a slide show in Continuous
mode. The LEFT and RIGHT ARROW keys will manually override the pace of your
presentation.

Random Expression Media Reader randomly chooses images and movies to present
onscreen.

Play voice annotation Plays any attached voice annotation whenever a media item is
loaded.

Play sound from all movies Plays all the available movie audio tracks simultaneously.
This option is only useful when you intend to play multiple movies in a grid arrangement.
If this feature is disabled, Expression Media Reader plays only the background sound
channel, as well as the active movie soundtrack.

Draw margin between media Adds a few pixels of background color to help separate
items from each other in multi-file grid arrangements.

Set background color Changes the background color of slide show presentations. The
default is set to black.

Set Transitions menu

Following are the options that appear in the Set Transitions menu.

None Specifies that there will be no transition between files.

Random Specifies that the transitions will be a random mix of the ones in the transition
list.

Transition list Expression Media Reader offers a basic set of QuickTime effects that
you can be use during slide show media transitions. The duration of the transition effects
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(1 second) is currently fixed. This setting will affect all media items, unless you define
them in the Slide Show controller.

Set Scaling menu

Choose an option from this menu to control the scale or size of media items. You can set this
option before or during an active slide show presentation.

Set Grid menu
Choose any of these options to adjust the number of files that display at once in the slide show.

Setting and viewing options for individual files in the slide show

Within the controller, you can set playback options for each one of the files. You can also assign
labels and ratings, set which text appears in the slide show, and which category of files plays in
the slide show. You can set options or view information as the slide slow plays, or you can pause
the show.

RN DALY
Fles [Ted [info_|

I sca2006120851... .
[/ sGA2006120854...
i sca2006120857...
JE# sca2006120862...

7 5GA2006120911.. TN NES S )

53

1) Use these menus to set global options; 2) Use these menus to set options for this individual file; 3) Use this
menu to set the timing options for this file.

To set playback options for individual files
1. Inthe list of files, click the file that you want to adjust.

2. Click the box aligned with the option menu corresponding to the option that you want to
adjust. For example, if you want to adjust the size of the image, click the box aligned
underneath the Set Scaling menu, and corresponding with the file that you want to adjust.

3. Set the option. The next time the Slide Show reaches this file, it will exhibit the
characteristic that you specified. When you set a transition for an individual file, you are
setting how the previous file transitions into the selected file.

To set the timing for individual files
1. Inthe list of files, click the file that you want to adjust.

2. Click the Timing menu (see the previous graphic), and then click an option according to
the following descriptions:

e To use the display time between files that you set in the timing selector at the top of
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the controller, click Default (use global timer).

e To assign a special duration for the file to display, click Display for set duration.
Once you click this option, use the arrows that appear to the right of the file name to
designate a display time in seconds.

e To pause the slide show at this file until an audio file, such as an audio annotation,
plays completely, click Hold slide show until sound finishes.

To show a subset of files

At the bottom of the Slide Show dialog box, click the button corresponding to the type of files
that you want to show and do any of the following:

e On the Show Rated menu %, click a rating to show only files with that rating.

e On the Show Labeled menu ¢!, click a label color to show only files with that label.
e On the Show Sets menu "/, click the name of the set that you want to display.

e To show all of the files again, click the Show All button #

To designate the text that appears in the slide show
1. Click the Text tab.
2. Do any of the following:

e Select any of the Display options to display the text related to that option. Click the
arrows to cycle through all the available information.

e To set the color of the text, click the Color swatch, and then select a color.
o To right-align, center, or left-align the text, click the corresponding Align button.
° On the Font menu, click one of the font options. Drag the slider to set a font size.

To set a label or rating

Do one of the following:

e To seta label, click the Files tab, click the banner to the left of the file name, and then
click a label color.

e Tosetarating and a label, click the Info tab and, next to the thumbnail of the file,
click the swatch to assign a label and click the “plus” marks next to swatch to set a
rating.

To view file information
1. Click the Info tab.
2. Click the arrows at the bottom of the dialog box to cycle through the file information.

Light Table mode

Light Table mode is the best way to view an image or compare up to six different images at one
time.
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The default display of the Light Table is the chosen number of images shown in a Grid layout
(2x2) with a toolbar for each image. The toolbar shows the color label, file name, dimensions
and scaling percentage of each image. The toolbar also displays buttons for trashing or removing
images, rotation, and display size.

When you have more than one image showing in the Light Table, try using the Landscape,
Portrait, or Grid layouts (shortcut keys are L, P and G, respectively) to use your monitor space as
efficiently as possible. The layout that works best for you depends on the orientation of your
images, how many images you want to view at one time, and whether you want to see the toolbar
and/or the histogram. You might want to hide the toolbar to maximize the viewing area for each
image (shortcut key is T).

To enter Light Table mode
1. Select between one and four images in List View or Thumbnail View.
2. On the View menu, click Light Table.

Note: When you first launch the Light Table, the Help menu appears showing the
navigation and keyboard shortcuts. Click the menu to close it. If you need to open it again
to view shortcuts, right-click (Windows) or CTRL-click (Macintosh) anywhere in the
window and, in the context menu, click Shortcuts.

To mark an image in Light Table mode

Position the cursor over the image that you want to rate (if you have more than one image in the
Light Table) and press numbers 1 through 9 to set a label (or O [zero] to remove a label).

To adjust the image size

In the Size menu at the bottom-right corner of the images, click a display size option. To zoom in
on an image, press the PLUS (+) and MINUS (-) keys. With the Scroll Lock key on, all images
will increase and decrease by the same magnification. With the Scroll Lock key off, only the
scale of the active image will be adjusted.

Scroll, Scroll Lock, and Zoom

When an image is bigger than the window it is in, the cursor will turn into a hand, which you can
then use to move the image by dragging.

When more than one image displays in the Light Table, all images will be moved simultaneously
while Scroll Lock (keyboard shortcut: S) is on. If any of the images do not move when scrolling
in this way, it is probably because they fit the current window and there is no more of the image
to show.

With Scroll Lock off, you can move only the image under the cursor by dragging. The Scroll
Lock key is useful when examining an important area of similar images.

By zooming in and scrolling to the part of an image you are interested in, the other displayed
images will show the same portion of the image.
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If the images are not absolutely identical, you might need to turn Scroll Lock off and move the
image individually. Remembering the keyboard shortcut (S) for the Scroll Lock makes viewing
similar images much faster.

Next and Previous images

The RIGHT or DOWN ARROW key changes the image in the Light Table to the next one in the
catalog. Use the UP or LEFT ARROW key to change to the previous image in the catalog.

When there is more than one image on the screen, the image that is changed is the one your
cursor is positioned over. When changing the image by using the cursor keys, the current zoom
and scroll positions are maintained to make it easier to examine the same point on similar
images.

Pixel Magnifier

The pixel magnifier is a floating panel that shows a close up of the image area underneath the
cursor. To select the pixel magnifier, use the M keyboard shortcut. The pixel magnifier can be
quicker than zooming and scrolling, particularly when there is more than one area in any
particular image that you need to examine closely.

The slider controls how far the magnifier zooms in. There are four settings from the least
magnified at the bottom, to the most magnified at the top. The slider snaps to one of these four
settings.

The pixel magnifier also shows the X/Y coordinates of the cursor (highlighted by a green
square), as well as the RGB color values.
Using the Histogram and Exposure warnings

A histogram is a graph showing the relative distribution of Red, Green, and Blue pixel densities
in an image. It shows the number of pixels with high density on the left (darker colors) and low
density on the right (lighter colors). Its purpose is to show the distribution of tone throughout an
image.

200 @ 100%

The histogram

When viewing images, you might want to view the Histogram and Exposure warnings for each
image.
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For example, an image with no shadows will have a histogram with a valley on the left, while a
histogram with no highlights will have a valley on the right. You can see dark shadows as a peak
of all three colors to the left and bright highlights a peak of all three colors of the right.

In the image shown, the exposure warnings show areas of potential overexposure as solid red,
and show under exposed areas in solid blue. Those over exposed and under exposed areas of an
image generally lack detail due to too much or too little light being captured. Use the histogram
and exposure warnings only as a guideline to help you make a decision about whether an image
is good or can be improved.

To launch the histogram and exposure warnings

While you are in the Light Table view, press H to show/hide the histogram, and press W to show
the exposure warnings.
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Chapter Nine:
Printing

You can print files from the catalogs you receive. Expression Media Reader provides diverse
options so that you can be a flexible in how you view or present hard copies of catalog images
for associates, for publication, or for archiving.

Printing modes

Microsoft Expression Media Reader offers three printing styles, Content List, Contact Sheet, and
Media Sheet. These styles match the three views available in the program. The Print dialog box
automatically defaults to match the active view of your catalog. The dialog box shows a real-
time preview of your prints. Expression Media Reader displays each of your option changes in
the preview window.

Content List This list is useful for printing a table of contents for a catalog. The style matches
the layout of the catalog’s List View, with icons and associated field information of each file.
This style also includes options for showing/hiding icons and field headers on the printout. The
size of the icons in your catalog’s List View determines the size of the icons in the printout.

" Print 5

Print: | Content List -

|Fu|| Page hd |

Margins...
Headers...

SEEEpELIaGEuALIEpLGY

Options:

ERTEGUEEEREaIIRREREE

| Print label row

SRR

| Print item icons
Corner crop marks

AEEASEE

Sl R leE S InEREOSmI N0 00 A WELIL]
ERE

Use view colors

| Page 1of 1@8.1by 10.6in,
1by 39 Cells @ 8.1by 0.3in.

Range: |Deﬁne in Print Box v| | Page Setup... Print | | Cancel

Content List printing

Contact Sheet The contact sheet prints a table of thumbnails similar to your catalog’s
Thumbnail View. The size of the thumbnail in your catalog determines the size of the thumbnail
in the printout.
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Thumbnails are imported into the catalog by using the file’s built-in thumbnail or by using
images created by Expression Media Reader.

You can also select the Hi-Res Thumbnails option for quality printing. Selecting this option
will send more image detail for every thumbnail to the printer, so allow extra time for printing.
The printing speed is dependent on your computer’s processing power and the type of printer.

ééi

Print

Print: [Contact Sheet -

Margins...
Headers...

Options:

[T Hi-Resolution thumbnails
[¥] print view fields

[ Corner crop marks

[T use view colors

+| Page 20f 3@8.1by 10.6in.
~! 3by4Cells @ 2.7by 2.7in.

Range: [Deﬁne in Print Box V]

Contact Sheet printing

Media Sheet Renders the full size, hi-resolution images from original files. Note that you will
need the original files before in order to have a satisfactory print out. If the catalog creator did
not include the original files, then this option will not produce good results. Because some of
these files can be quite large, allow extra time for printing. You can change the size of the

displayed and printed media in the Scaling menu #! in any view.

The most useful of these options is Scale to Fit, as it automatically rescales the image to fit
within the print area. Other useful options are Actual Size and Fit Width, but they might hide
parts of the image when the size and shape of the original image is larger than the rendered area
or printed cell size.

37



" Print 7]

Print: |Media Sheet -

Margins...

Scaling:
[Scale toFit -

Options:
[¥] Margin between
[V Print view fields

|| Corner crop marks

[T use view colors
["]Repeat media

+| Page 170f 33 @8.1by 10.6in.
~| 1by 1Cells @ 8.1by 10.6in. R

Range: [DeﬁneinPrintBox V] [ Page Setup... J

Media sheet printing

To print from Expression Media Reader
1. Do one of the following:
e Select the image that you want to print.
e If you want to print several images, select them and, on the Find menu, click Show
Selected.
2. On the File menu, click Print or click the Print button on the toolbar.
3. Select a print option from the Print menu.

4. Depending on the options you choose, you will have varying options to choose from. See
the following sections for explanations about each option.

5. When you make your selections, click Print.

To print alayer or page within a composite file

1. Expression Media Reader prints only the frame assigned as an item’s thumbnail. To print
another layer or page, go to the page or layer you want to print in Media Reader View.

2. Before printing, click Rebuild Item on the Action menu.
3. On the File menu, click Print.
4. Select your options, and then click Print.

Global print options
The following options are available, regardless of the printing method you choose.

Define the Print Area This menu has options for full page, as well as CD and other disk cases,
such as a Zip or Jaz disk. If you select Full Page, Expression Media Reader uses the page size
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defined in the Page Setup dialog box. The options will differ according to the type of printer
chosen. You can add custom print area templates to this menu.

Margins Enables you to further adjust the Print Area Size on all sides. Select the Mirror
Margins option to include spines for double-sided documents that will be bound or punch-holed.
The border color around the preview image represents the margins that you define.

Headers Enables you to place a label on the top (header), bottom (footer), right and left sides of
your printout, depending on which of the buttons you click on the right side of the text boxes.
You can adjust the type and style of the labels by clicking the buttons on the right side of the text
boxes. On the Special menu, add automatic page numbers, date, and time. These are represented
by their respective symbols in the caption’s box. You can mix the symbols with regular text. Use
the Ampersand (&&) option to help differentiate the character from the special character
commands. The Indent option aligns the label center or right. An Indent (&i) centers the text.
Two indent marks makes the text flush right.

Expression Media Reader retains Header settings across all print styles.

Grid (not available in Contact List mode) For contact sheets, this option defines the number
of rows and columns for a printout. For media sheets, you can define how multiple copies of the
same image, or different images, will be printed. The Default for view option takes into account
the image size settings for the respective view of the catalog. The Cells option enables you to
define the number of rows and columns. The Size option is similar to cells, but allows you to
define the exact size of each cell.

Use view colors Mimics the style of the view corresponding to the printing mode that you
choose. For example, if you chose to print using the Content List mode, then if you select this
option, the dividers between the image listings will display in your printout.

Corner crop marks This option adds crop marks to the corners of the entire sheet.

Page Preview Navigator If you are printing multiple pages, click the arrows to choose a page
that will display in the preview section on the right side of the Print dialog box.

Range Modifies which pages will print. The default is to allow your printer’s dialog box to
handle this function. You can also choose Current Page, or Odd or Even pages.

Additional printing options in Contact Sheet mode
Following are the options available if you choose Contact Sheet mode to print your photographs.

Hi-Res Thumbnails By default, Expression Media Reader prints low resolution thumbnails.
Select the box to print high-quality images.

Print view fields This option will enable you to print the text fields that are visible in
Thumbnail View, in addition to the image.
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Additional printing options in Content List mode
Below are the options available if you choose Content List mode to print your photographs.

Print label row Select this option to print the headers for each row.

Print item icons Select this option to print the image icons at the size you specified in the List
View options.

Additional printing options in Media Sheet mode

Below are the options available if you choose Media Sheet mode to print your photographs.
Because Expression Media Reader renders these prints from the original, hi-resolution images,
make sure that the catalog creator included a copy of the original images along with the catalog
file. These files might be large, so allow extra time for printing.

Margin between Select this box to place a small amount of space between tiled images.

Repeat media Select this option to tile a single image in the available print area. Click the Grid
button to define the number and size of the tiled images.

Scaling To define the image size, select one of the following options on the menu:

e Actual Size Uses 100% of the image and centers it in the Print Area.
e Scale to Fit Scales the image proportionally to the size of the Print Area.

e Fit Width Scales the image based on the horizontal parameters of the Print Area. If
you apply this to a vertical image, some of it might not be visible.

e Fit Height Scales the image based on the vertical parameters of the Print Area. If
you apply this option to a horizontal image, some of the image might not be visible.

e Pin Smaller Side Draws the image with its smaller side expanded to fit the screen.
This option will fill the entire screen, but your image might be cropped.

e Pin Larger Side Draws the image with its larger side expanded or shrunk to fit the
screen.

e Tile Tiles the image (in actual size) in the window. This option is helpful when you
are printing patterns.

e Percentages Allows reduction or enlargement of the image from 25 percent to 2000
percent.

e selector Use the UP and DOWN ARROW keys to choose which page appears in the
preview window on the right side of the dialog box.
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Appendix A: Troubleshooting

Basic troubleshooting
Make sure that you have installed the following software:

e The latest version of Expression Media Reader from our site:
http://go.microsoft.com/fwlink/?Link|D=82546

To check for updates, on the Help menu, choose Welcome Screen. If an update is
available, a link will be provided for you to download it. On the Macintosh, Check for
Updates is located in the Application menu, and is located in About Expression Media
Reader.

e The latest version of Apple QuickTime from Apple’s site.

e Windows users should keep up to date with the latest service packs and drivers for their
operating system. Use the Windows Update command on the Start menu to download
and install the latest updates.

e Macintosh users can solve problems by deleting the Expression Media Reader
preferences in the system’s Preferences folder (~User/Library/Preferences/Expression
Media Reader Prefs).

Note: Expression Media Reader should not be running while this is being done.

Web resources

Customer Support If you have additional questions, make sure you check the documentation
and the community forum. If you still can’t find an answer, See our online Web site at
http://go.microsoft.com/fwlink/?Link|D=82546
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